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Applications Notes for Avaya IP Office 6.1 with AT&T IP Toll
Free SIP Trunk Service — Issue 1.0

Abstract

These Application Notes describe the steps for configuring Avaya IP Office with the AT&T IP
Toll Free service. Avaya IP Office solution was tested with AT&T IP Toll Free service
supports using MIS/PNT transport.

The AT&T IP Toll Free service is a managed Voice over IP (VoIP) communications solution
that provides toll-free services over SIP trunks for business customers.

AT&T is a member of the Avaya DevConnect Service Provider program. Information in these
Application Notes has been obtained through compliance testing and additional technical
discussions. Testing was conducted via the DevConnect Program.
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1. Introduction

These Application Notes describe the steps for configuring Avaya IP Office Preferred Edition with
the AT&T IP Toll Free service. Avaya IP Office solution was tested with AT&T IP Toll Free
service supports using MIS/PNT transport.

The AT&T IP Toll Free service is a managed Voice over IP (VoIP) communications solution that
provides toll-free services over SIP trunks for business customers.

2. General Test Approach and Test Results

The test environment consisted of:

e A simulated enterprise with IP Office, Avaya phones and fax machines (Ventafax application).

e A laboratory version of the AT&T IP Toll Free service, to which the simulated enterprise was
connected via MIS/PNT transport.

The main test objectives were to verify the following features and functionality:

e Inbound AT&T IP Toll Free service calls to IP Office hunt groups/telephones.

e Call and two-way talk path establishment between PSTN and IP Office phones via the AT&T
Toll Free service.

¢ Basic supplementary telephony features such as hold, resume, transfer, and conference.

e (G.729 and G.711 codecs.

e T.38 fax calls between IP Office and the AT&T IP Toll Free service/PSTN G3 and SG3 fax
endpoints.

e DTMF tone transmission using RFC 2833 between IP Office and the AT&T IP Toll Free
service/PSTN automated access systems.

e Inbound AT&T IP Toll Free service calls to IP Office that are directly routed to stations, and
unanswered, can be covered to Voicemail Pro.

e Long duration calls.
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2.1. Interoperability Compliance Testing

The interoperability compliance testing focused on verifying inbound and outbound call flows (see
Section 3.2 for examples) between IP Office and the AT&T IP Toll Free service.

The compliance testing was based on a test plan provided by AT&T, for the functionality required
for certification as a solution supported on the AT&T network. Calls were made from the PSTN
across the AT&T network (see Section 3.2 for sample call flows). The following features were
tested as part of this effort:

e SIP trunking

e T.38 Fax

e Passing of DTMF events and their recognition by navigating automated voice menus

e PBX and AT&T IP Toll Free service features such as hold, resume, conference and transfer

e Legacy Transfer Connect

e Alternate Destination Routing

2.2. Known Limitations/Test Results

1. G.711 faxing is not supported between IP Office and the AT&T IP Toll Free service. T.38 faxing
is supported, as is Group 3 and Super Group 3 fax.

2. AT&T IP Transfer connect option of the AT&T IP Toll Free service was not verified with Avaya
IP Office 6.1 and hence not supported.

3. Shuffling is not supported for SIP trunks in Avaya IP Office 6.1.

4. G.726 codec is not supported Avaya IP Office 6.1.

The test objectives stated in Section 2 with limitations as noted in this section were verified.

2.3. Support
AT&T customers may obtain support for the AT&T IP Toll Free service by calling (888) 325-5555.

Avaya customers may obtain documentation and support for Avaya products by visiting
http://support.avaya.com. In the United States, (866)GO-AVAY A (866-462-8292) provides access
to overall sales and service support menus. Customers may also use specific numbers (provided on
http://support.avaya.com) to directly access specific support and consultation services based upon
their Avaya support agreements.
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3. Reference Configuration

The reference configuration used in these Application Notes is shown in the figure below and
consists of several components:

IP Office provides the voice communications services for a particular enterprise site. In the
reference configuration, IP Office runs on an IP 500. This solution is extensible to other Avaya
IP Office hardware too.

Avaya “desk” phones are represented with Avaya 1616, 4625 and 9630 IP Telephones running
H.323 software, Avaya 1416 digital phone, Avaya 6211 Analog Telephone, Avaya SIP Phones
(1140E and 1230) and PC based IP Office Softphone.

Voicemail Pro provides the voice messaging capabilities in the reference configuration and its
provisioning is beyond the scope of this document.

Inbound calls from PSTN were sent from AT&T IP Toll Free service to IP Office. IP Office
terminated the call to the appropriate agent/phone or fax extension. Signaling is between IP
Office public interface and the AT&T Border Element.

Enterprise sites may have additional or alternate routes to PSTN using analog or digital TDM
trunks. However these trunks were not used in this reference configuration.

ATET
MIS/PNT Transport

ATAT

Network IP Toll Free Service

i N . ™
Enterprise Office
AT&T Router
WAN Port
i i Avaya 6211
Avaya 1416 Avaya IP Office | LAN Port (Analog) X201
Digital) X205
PRIVATE IP ADDRESS SPACE (Corporate) )
;
& PC with IP Office L
Manager and Voicemail | AS\I';Y:h1 230
- — one
PC with e e Avaya 4625  y21
Ventafax = IP Phone
f ? Avaya 9630 X202
IP Phone Avaya 1140E Avaya 1616
Kan SIP Phone IP Phone
PC with IP Softphone X220 X203
X206
-
Figure 1: Reference configuration
AT:Reviewed Solution & Interoperability Test Lab Application Notes 5 of 46

SPOC 6/3/2011 ©2011 Avaya Inc. All Rights Reserved. IPO61IPTF




3.1. lllustrative Configuration Information

The specific values listed in the table below and in subsequent sections are used in the reference
configuration described in these Application Notes, and are for illustrative purposes only.
Customers must obtain and use the specific values for their own specific configurations.

Note - The AT&T IP Toll Free service border element IP addresses shown in this document are
examples. AT&T Customer Care will provide the actual IP addresses as part of the AT&T IP Toll
Free service provisioning process.

Component Illustrative Value in these
Application Notes
Avaya IP Office
Public IP Address 192.168.62.56
Private I[P Address 10.80.130.56
Avaya IP Office Extensions 201 = Analog

202,203,204=H323
205=Digital
206=Softphone
220,221= SIP phones

AT&T IP Toll Free Service
Border Element IP Address 135.242.225.200
Digits passed in SIP-URI Request 000001017 to 000001021

Table 1: Illustrative Values Used in these Application Notes
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3.2. Call Flows

To understand how inbound and outbound AT&T IP Toll Free service calls are handled by IP
Office, two basic call flows are described in this section.

3.2.1. Inbound

The first call scenario illustrated in the figure below is an inbound AT&T IP Toll Free service call
that arrive on IP Office, which in turn routes the call to a hunt group, phone or a fax.

A PSTN phone originates a call to an AT&T IP Toll Free service number.
The PSTN routes the call to the AT&T IP Toll Free service network.

The AT&T IP Toll Free service routes the call to IP Office.

Depending on the called number, IP Office routes the call to

e A hunt group, which in turn, routes the call to an agent

e Directly to an agent or a phone/fax extension.

b e

1 AT&T
IP Toll Free

PSTN
Phone

IP Office

Inbound - AT&T IP Toll Free
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3.2.2. Coverage to Voicemail

The call scenario illustrated in the figure below is an inbound call that is covered to voicemail. In
this scenario, the voicemail system is Voicemail Pro software installed on a PC.

1. Same as the first call scenario in Section 3.2.1.
2. The IP Office phone does not answer the call, and the call covers to the phone’s voicemail. IP
Office forwards the call to Voicemail Pro.

1 AT&T
IP Toll Free
PSTN
Phone
2
IP Office » Voicemail Pro
Phone
Coverage to Voicemail
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4. Equipment and Software Validated

The following equipment and software was used for the reference configuration described in these
Application Notes.

Note — Although Avaya IP Office Preferred Edition was used during this testing; Avaya IP Office
Essential and Advanced Editions are also supported.

Component Version
Avaya [P Office 500 Release 6.1 (6.1.5) (Preferred Edition)
Avaya [P Office Manager Release 8.1 (8.1.5) (Preferred Edition)
Avaya IP Office Voicemail Pro Release 6.1.16
Avaya IP Office Voicemail Pro Client Version 6.1 (16)
Avaya 1616IP-Series Telephones (H.323) Release 1.3
Avaya 9630 IP Telephone Avaya one-X® Deskphone Edition
H.323 Version S3.11
Avaya 4625SW IP Telephone a25d01a2 9 1.bin
Avaya IP Office Softphone Release 3.1.2.17 59616

Avaya 1416 Digital Telephone -
Avaya 6211 Analog phone -
Avaya 1140E SIP Telephone 04.00.04.00 (SIP1140)

Avaya 1230 SIP Telephone 04.00.04.00 (SIP1230)
Fax device Ventafax Home Version 6.2
AT&T IP Toll Free Service using VNI 18

MIS/PNT transport service connections.

Table 2: Equipment and Software Versions
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5. Avaya IP Office

IP Office is configured via the IP Office Manager program. For more information on IP Office
Manager, consult reference [[PO-MGR]. From the IP Office Manager PC, select Start —
Programs — IP Office — Manager to launch the Manager application. A screen that includes
the following in the center may be displayed:

WELCOME to IP Office Administration

What would you like to do ?

Create an Offline Configuration

Open Configuration from System

Read a Configuration from File

Open the IP Office configuration, either by reading the configuration from the IP Office server, or
from file. The appearance of the IP Office Manager can be customized using the View menu. In

the screens presented in this section, the View menu was configured to show the Navigation pane

on the left side, and the Details pane on the right side.

5.1. Physical, Network, and Security Configuration

This section describes attributes of the reference configuration, but is not meant to be prescriptive.
Consult reference [[PO-INSTALL] for more information on the topics in this section.

In the reference configuration, the IP Office 500 contains a Phone2 (analog), Phone2/PRIS U
(Combo module), VCM32, and a DIGSTAS (Digital) modules. The VCM32 is a Voice
Compression Module supporting VoIP codecs. The Analog module (Phone2) was used in this
reference configuration to support analog telephones or fax machines. The Digital module
(DIGSTAS) was used to support digital phone extensions.

The following screen shows the modules in the IP Office used in the sample configuration. To
access such a screen, select Control Unit in the Navigation pane. The modules appear in the
Details pane. In the screen below, IP 500 is selected in the Navigation pane, revealing additional
information about the IP 500 in the Details pane.

IP Offices & IP 50
R BOOTP (3) Urit
47 Operator (3) T
-5 DOENO7OSSETZ Device Number 11 |
£ = System (1) Uit Type e §
w3y O0EOO7OSSF72 e — |
9 Line (3} Yersion 6.1 (5}
(== Control Unit {5} -_—
< 1P 500 Setial Mumber jppedovosstrz ]
“Lr 2 PHOMEZ ; [
<o 3 PHONEZ{PRIS U Unit IP Address |192.168.62.56
e 4 YCM32 Interconnect Mumber o
“2r 5 DIGSTAS
Ay Extension (28) Module Mumber gControI Linit
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In the sample configuration, the IP Office LAN1 port (labeled as WAN in Figure 1) is physically
connected to the public network at the IP Office customer site. The default gateway for this
network is 192.168.62.1.

1. To add an IP Route in IP Office, right-click IP Route from the Navigation pane, and select
New. To view or edit an existing route, select IP Route from the Navigation pane, and select
the appropriate route from the Group pane. The following screen shows the Details pane with
the relevant default route using Destination LAN1 (Refer Section 5.3.2).

IP Offices Ej 0.0.0.0°

K’ BOOTP (3 IF Route |

i+ Operator (3) ' ]

- *= DOEOD7OSSF72 IF Address 0 0 o 0 |
=55 System (1) 1P Mask [ o 0 i ]

sy OOEDO7OSSF72 :

7 Line (3) Gateway IP Address 192 . 168 . 62 1

“2y Conkrol Unit {5)

A Extension (23} Lestination JLar1

i User {20 Metkric o
@ Huntisroup (107
8¢ Short Code (65) [ Proxy ARP

@ Service (0}
al; RAS (1)

@ Incoming Call Route {11} %

EE! wanPork (0}

@ Directory (0)

F,”‘- Time Profile {0}
@- Fireweall Profile (1)
=l 1P Route (3)

ER 0.0.0.0
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2. Another route was added for the enterprise side (LAN2) as shown in the screen below. All the
IP devices were part of this 10.80.130.x network in this reference configuration.

IP Offices

K BooTR(3)
{# Operator (3)
(== ODEOO7OSSFTZ
[=)-*52p System (1)
=) OOEOOFOSSFFZ
4 Line (3)
<2 Control Unit (50
Ay Extension (28)
a User (20)
-ﬂ HuntGroup (10}
B short Code (65)
@ Service (0)
il RAS(1)
% Incoming Call Route (11)
$8 wanPart (0)
#m Directory (0)
£ Time Profile (0)
{8 Firewall Profile (1)
=l IP Route (33
Kl 0.0.0.0

IP Raute |

IP Mask.

[etric

IP Address

Gateway IP Address

Destination

[] Proxy aRP

3. For use of Avaya IP Office Softphone, https was enabled in this reference configuration. To
check whether https is enabled, navigate to File > Advanced -> Security Settings and login
in with proper credentials in the screen below.

Security Service User Login

IP Office :

Service User Mame

Service User Password

QOEQO7OSSFYE - IP S00

securiby

[w]'d H Cancel ][ Help

AT:Reviewed
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4. After logging in, select System from the Navigation pane and the appropriate IP Office system.
In the Details pane, select the System Details tab. Verify that Allow HTTPS is checked. If
not, check the box, click OK, and heed the on-screen prompts and warnings. Note that this
action may be service disrupting.

Security Settings System : DOEOQO7055F72
= £ Secuiy System Details | Unsecured Intefaces
@ General . Bage Configuration
= ] rr (] [
w5 DOEOOTORSFT2 Services Baze TCP Part |50304 &
8} Sn.ervices 4] Maimum Serica s BT
129 Rights Groups (5] % ....................................................................
h Service Users (4] t amimurn Rights Groupz |8

Syztem Discovery
TCP Discovery Active LIDP Discovery Active

Security

Session ID Cache [Hourg] |10 £

Allows HTTPS

Server Certificate

(Offer Certificate Teie

Private Key

lzsued ba IP Office O0e007055F72

[ Set ][ Wie ][ Delete ]

5. When complete, select File = Configuration to return to configuration activities.
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5.2. Licensing

The configuration and features described in these Application Notes require the IP Office system to
be licensed appropriately. If a desired feature is not enabled or there is insufficient capacity,
contact an authorized Avaya sales representative.

1. To verify that there is a SIP Trunk Channels License with sufficient capacity, click License in
the Navigation pane and SIP Trunk Channels in the Group pane. Confirm a valid license with
sufficient “Instances” (trunk channels) in the Details pane.

IP Offices = SIP Trunk Channels

B IPS00 Yoice Mebworking Channe # (| | Licenses |
W IPSec Tunneling

Sz Microsoft CRM Inbegration (uset License Key | @vyedROESEEQhIPIMBMLYZICZDUrS09
% Mobile worker 0
W Mobility Features License Tvpe  |SIP Trunk Channels I

W Office Worker ) .
W one-¥ Portal For IP Office License Status | alid

% Phone Manager Fro — —
% Phone Manager Pro (per seat) ........................................................................................
& Phone Manager Pro IP Audio En Expiry Date Terver

W Power User

W Preferred Edition (WoiceMail Prao)
W= Preferred Edition Additional Yoic
W Proactive Reporting

W RAS LRQ Support (Rapid Respol
W Receptionist

W Report Viewer

BN oo

2. If Avaya IP Telephones will be used, verify the Avaya IP endpoints license. Click License in
the Navigation pane and Avaya IP endpoints in the Group pane. Confirm a valid license with
sufficient “Instances” in the Details pane.

IP Offices = Avaya IP endpoints

B Short Code (65) # || Licenses |

@ Service (00
g RAS (1) Licerse Key |64u_@wdSMKv?nsEdBkﬂ@chiPmNsEzl1
@ Incaming Call Rouke (5)

ﬁﬂ \WanPart {07 License Tvpe |F'.\-'ava IP endpaints

am Directory (00
f:f" Tire Prafile (0%
@ Fireweall Prafile (1)
BB IF Route (3)
i Account Code (0) Expiry Date |Never
(=)W, License (72)
B 1600 Series Phones
& 3rd Party IP Endpaints
B Advanced Edition
B Advanced Small Communiby Met
B AUDIY Yaicemail
U Avava IP endpoints

Instances |255

—

|
|
License Skatus |\-'a|i|:| |
|
|
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3. The following screen shows the availability of a valid license for Power User features. In the
sample configuration, the user with extension 203 will be configured as a Power User and will
be capable of using the IP Office Softphone.

B IPS00 Voice Metworking Channe # || |icenses |
W IPSec Tunneling

% Microsoft CRM Integration (user License Key | OUH342yFLNSSALSW1ZM_g@datEyeytra
% Mobile Workee oV}
. Mobility Features License Tvpe | Power Lser

W Office Worker
W one-» Portal for IP Cffice
. Phone Manager Pro

License Skatus | Valid

Instances 255
. Phone Manager Pro{per seaty | 00— —
. Phone Manager Pro IP Audio En Expiry Date Mewver
L M FPower User
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5.3. System Settings

This section illustrates the configuration of system settings. Select System in the Navigation pane
to configure these settings. The configuration in following sections is for reference purposes only.

5.3.1. System Tab

With the proper system name selected in the Group pane, select the System tab in the Details pane.
The following screen shows a portion of the System tab. The Name field can be used for a
descriptive name of the system. In this case, the MAC address is used as the name. The Avaya
HTTP Clients Only and Enable SoftPhone HTTP Provisioning boxes are checked to facilitate
IP Office Softphone usage.

IP Offices Ei 00EO(

"F BOOTP (3) System | LaM1 | LANZ | DNS || Yoicemail | Telephony | Directory Se
e Opergtor(zy e
[=)-*%=p Q0EODYOSSFYE Marme DDEDD?DEEF?Z ...................
-9 System (1) Contact InfFormation
%=y OOEDOVOSSFZZ
7 Line (3) Set conkact information to place System under special control

<2 Contral Uit £5)
@a Extension (23) ...............................................................................
ﬂ User (20}
-ﬂ Hunt@roup {10}
@ Shart Cade (55) TFTP Server IP Address 0 0 ] o
B Service (0)
oy RAS (1) HTTP Server IP Address
3 Incoming Call Route (11
$8 wanPort (0

Phone File Server Type

@i Direckory (0) Manager PC IP Address
£ Time: Profile (0) :
@ Firewall Profils (1) Avava HTTP Clienks Only
[l 17 Route (3) Enable SaftPhone HTTF Provisioning
g Account Code (0)
i v
& License (72) fondicbacopsomnd 8B
& Tunnel (0) Time Setting Config Source yoicemail ProfManager W |
A || et eeee . Rl SR J
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5.3.2. LAN Settings

In the sample configuration, LAN1 was used to connect the [P Office to AT&T Network and
LAN?2 was used to connect to the enterprise network.

1.

Select the LANI1 tab followed by the LAN Settings tab and configure as follows:
e JP Address — Set to 192.168.62.56 which is the IP address of IP Office known to AT&T
network
e IP Mask — Set to a valid value e.g. 255.255.255.0
e Primary Trans. IP Address — Set to 0.0.0.0
e DHCP Mode — Select the Disabled radio button
IP Offices E O0EDOOTOS5F72
R BoOTP (3) System | LAML | LaNz | DNS | Yoicemail | Telephare | Direckory Services | System Ew
{7 Operator (3)
) %% ODEOO7OSSF72 LAN Settings | yoIP || Mebwork Topology
T e T P e EECRCEEY
7 Line (3) IP Mask (255 255 255 . O
<2y Control Unit {5) e ——
A%y Extension (28) Primaty Trans. IP Address | @ ] ] ]
§ userizo —— ;
ﬂ HunkGroup {10} RIF Mode (Mome__ | -
93¢ short Code (55) [] Enable NaT
@ Service (1) :
wl, RAS (1) Mumber O DHCP TP Addresses 200
@ Incoming Call Route {11) DHEF Mode
Ej) WWanPork {00
s Directory (0} ) server (0 Client (O Dialin (%) Disabled w
AT:Reviewed Solution & Interoperability Test Lab Application Notes 17 of 46
SPOC 6/3/2011 ©2011 Avaya Inc. All Rights Reserved. IPO61IPTF



2. Select the VoIP tab as shown in the following screen and configure as follows:
e SIP Trunks Enable — Check this box to enable the configuration of SIP trunks
e RTP Port Range (Minimum) — Set to 16384 (As required by AT&T)

e RTP Port Range (Maximum) — Set to 32766 (As required by AT&T). Although AT&T
requires the maximum value to be 32767, IP Office requires an even number to be entered

in this field

K
B
EI ey

-

(e R e e |

BEOOTR (3]
Operatar (3)
OQEQOFOSSF?2

(=)= Syskem (1)

=) OOEQOFOSSF72
T4 Line (3)
> Contral Unit (5
4y Extension (28)
§ user(z0)
5§ HuntGroup (10
@ Short Code (65)
B service (0

ol RAS (1)
2 Incaming Call Rauke (11)
B8 wanPart (0)
o Directory (0)
£ Time Profile (0)
{0 Firewall Profile (1)
EB IF Route (3)
g Account Code (0)
W License (72)

& Tunnel (0}

IP Dffices i=

System | LAML | LaNZ | DNS

LAM Settings | VoIP

Metwork Topology

[] H323 Gatekeeper Enable
SIP Trunks Enable
[] s1P registrar Enable

RTP Port Mumber Range

H323 Auko-create Extn

Port Range {Minimum)

[] H323 Auto-create User

Enable RTCP Monitoring
2n Pork S005

Diff3ery Settings

G2

ol |

S| D3cPiHex) FC 2

2| pscp 6 3

Port Range (Maxirmurn)

DSCP Mask (Hes) |70

DSCP Mask 28

O0OEOO7055F72

‘oicemail | Telephony || Directory Services | Swstem B

[teza¢ %]

% | =16 DSCP (He)

2| siGosce

3. Select the Network Topology tab as shown in the following screen and configure as follows:

e Firewall/NAT Type - Select Open Internet from the drop-down list. With this

configuration, STUN will not be used but make sure to leave STUN Server IP Address to

its default value.
e Public IP Address — Set to 0.0.0.0 (default)
e Public Port — Set to 5060 (default)

AT:Reviewed

IP Offices

K BoOTP (3)

¢ Operator (3)

[=)-%=p OOEOO7OSSF?2
=539 System (1)

9 Line (3)

<2 Contral Uit £5)
Ay Extension (28)
ﬁ User (20}

@ Service (1)
sl RAS (1Y

%) ODEOOYOSSFYE

-ﬂ Hunt@roup {10}
@ short Code (65)

LAM Setkings | YoIP
Metwork Topology Discovery
STUM Server IP Address .

Firewwall/MAT Twpe

Binding Refresh Time
(seconds)

Public IP Address

Public Port

Yoicemail | Telephony | Direc

Metwiork Topology

Swstem | LAML | LaNz | DNS
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4. Select the LAN2 tab followed by the LAN Settings tab and set IP Address of the IP Office on
the enterprise side to 10.80.130.56 and IP Mask to 255.255.255.0.

IP Offices B 00EOO

R BOOTP (3) System | LAN1 J LAMZ | DMS || Voicemail | Telephony | Directory Ser
{# Operater (3 | —
-5y OOEOOTOSSFET2 LAMN Settings | yoIP || Metwork Topology | SIP Regiskrar
(=557 System (1)
ey DOEOOTOSSET2 IP Address 10 an 130 56
T4 Line (2) 1P Mask
“2» Contral Unit (5
Ay Extension (26) Primary Trans. IP Address a0 a0 a0 ]
§ Useri19) ) I
ﬁ HunkGroup (4) Firewsall Profile <More> 0 &
#X short Code (85) RIP Mode Hone
@ Service (1)
ol RAS (1) [% [] Enable NAT
@ Incoming Call Rooker gsy o =
200 |
Eﬁ WanPart (1) Mumber OF DHCP IP Addresses |200 >
@i Directary {00 DHCF Mode
£ Time Profile (0
oy Server Clienk Dialin Disabled
{0 Firewall Profile (13 o O o ®

5. Select the VoIP tab as shown in the following screen and configure as follows:
e H323 Gatekeeper Enable — Check this box to allow the use of Avaya IP Phones
e SIP Registrar Enable — Check this box to allow SIP phones and IP Office Softphone usage

IP Offices

K BooTP (3)

ol RS (1)

@ Incoming Call Route {11}
Ej) WWanPork {00
i Direckory (0%
f.“‘ Time Profile {0}

@ Firewall Profile {13

EB IF Route (3}

B DOEQO7055F72

D H323 Auto-create User

Enable RTCP Monitoring
On Port 5005

DiffSery Settings

Port Range {Maximum) |

Swstem | LAM1 i LaNZ |DNS Yoicemail | Telephorey | Directory Services | Syskem
¢ Operater(zy —
= -%%y OOEQOFOSSFTZ LAMN Settings | WoIP |Netwnrk Topology || SIP Registrar
=529 System (1)
- ;..,” DOEDD7OSSF72 H323 Gatekeeper Enable
9 Line (3)
< Cantral Unit (5) [ sIF Trunks Enable
<y Extension (28) SIP Registrar Enable
a User (20}
ﬂ Hunt@roup {10}
@ Short Code (55) = RTF Part Mumber F.ange
; H323 Auto-create Extn : .
@ Service (0) Port Range (Minimum) 49152 &

am Account Code (0) B& T | DSCP{Hex) [FC % | DSCPMaskiHex) B8 T | 51 DSCP (Hex)
S License (72) 46 2| psce 65 3| DSCP Mask 3 3| siepsce
% Tunnel {0)
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6. The Network Topology screen is set the same as it was set for LAN1.

IP Offices

K BoOTP (3)
¢ Operator (3)
=)=y OOEOO7OSSF?2
=539 System (1)
%=y DOEOOFOSSF72
9 Line (3)
<2 Contral Uit £5)
Ay Extension (26)
ﬂ User (20}
-ﬂ Hunt@roup {10}
B short Code (55)
@ Service ()
o, BAS (1Y

Swstem | LaM1 ||--°\N2 EDNS Yoicemail | Telephorey | Dirgl

Firewwall/MAT Twpe

Binding Refresh Time
(seconds)

Public IP Address

Public Part

Metwork Topology Discovery

STUM Serwer IP Address | &9 a0 165 13

7. Set the Domain Name field to avaya.com and leave all the other fields to their default values.
This domain name is used to register the SIP telephones. Also, make sure that the Layer 4
Protocol field is set to Both TCP & UDP as Avaya IP Softphone uses UDP and the SIP

phones require TCP.

IP Offices

Operator (3)
%=y OOEOOTOSSF?2
=557 System (1)

%=y OOEOOFOSSF?2

T4 Line (4]
<2 Contral Unit (5)
Ay Extension (30)
& userizi
3§ HuntGroup (16
@ Short Code (67)

B Service (0)

K BooTR (3
H
=

System | LAN1 | LANZ

DN3 | Woicemail | Telephory

LAM Setkings | YoIP

Metwork, Topology SIP Registrar

Damain Marmne
Laver 4 Pratocol
TCP Port

UDP Pork

Challenge Expiry Time (secs) ;1'3

|avaya.com

. RAS (1) Auto-create Extn/User
8. Click OK [not shown] to commit.
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5.3.3. Voicemail

The settings presented here simply illustrate this reference configuration and are not intended to be

prescriptive. Select Voicemail tab and configure as follows:

e Voicemail Type — Set to Voicemail Lite/Pro from the drop-down list

e Voicemail IP Address — Set to 10.80.130.152, the [P Address of the PC running the Voicemail
Pro software.

IP Offices @ OOEQO7055F

K BOOTR (D

System | LaM1 | LaMZ | DWS | Veicemail | Telephony | Directory Services | Sw
i+ Operatar (3)

[=)-*%=p OOEQN7OSSF72 Woicemail Type Yoicemail Lite/Pro |
oo Sysemy T
2y ONEQNFOSSET2 Yoicemail Destination
T{tinel3) Vaicemail IP Address o 80 130 . 152 |
@y Control Umib¢(sy (@ — |
<y Extension (28] Backup Voicernail IP Address | O 0 0 o |
H-§  User (20) ) ) )
ﬁ HunbGroup (10) Woicemail Channel Reseryation
@ Short Code (850 Unreserved Channels
@ Service (1)

il RAS (1) Auto-Attendant Mandatary Woic

@ Incoming Call Route (11)

@ WarPort (1) Announcements
@& Directary (0) DTMF Breakout
f:.“ Time Profile (0} ¥

@ Firewall Profile (1) Reception [ Breakout (DTMF 0} |

n IP Raute (3:] Breakouk (DTMF 2) ------------------------------------------------
| Account Code (0) R e AR

W License (72) Breakout (OTMF 3) [
& Tunrel (D)
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5.3.4. System Telephony Configuration

The settings presented here simply illustrate the sample configuration and are not intended to be
prescriptive. Select the Telephony tab and Telephony sub-tab as shown and configure as follows:
Companding Law — Check the ULAW box for Switch field and ULAW Line box for the

IP Offices

=

-4

Line field.

Inhibit Off-Switch Forward/Transfer — Uncheck this box so that call forwarding and call
transfer to PSTN destinations via the AT&T Toll Free service can be tested.
Automatic Codec Preference — Use the default value of G.729(a) 8K CS-ACELP.

K BOOTR (%)
(7 Operabar (3)
%=y OOEOOFOSSFFZ
Sy System (1)

=y OOEOOFOSSF?Z
9 Line (2)
2 Control Unit (S)
A4 Exkension (26)
: User (19)
g HuntGroup {4)
B short Cade (55)
B service (0)
wl: RAS (1)
e Incoming Call Route (5)
EEI WanPort (00
s Directory (0)
{'.“ Time Profilz {0}
@ Firewall Profile (1)
BB P Route (3)

g Account Code (0)
W License (72)
% Tunnel {0}
n 3 User Rights ()
¢ ARS(1)
& RAS Location Regquest (00
#-f% F11 Svstem (1)

|

- ) ) ) )

[

[ [

System || LAML || LANZ | DRHS

Analogue Extensions

Default Outside Call Sequence
Default Inside Call Sequence

Default Ring Back Sequence

Dial Delay Time (secs)

Dial Delay Count

Default Mo Answer Time (secs)
Hold Timeout, {secs)

Park Timeout (secs)

Ring Delay {secs)

Call Priarity Promotion Time {secs)
Default Currency

Automatic Codec Preference

Yoicemail | Telephory Direckory Services || System Events | SMTP

Telephony | Tones & Music || Call Log

ENDrmaI v
maTel v
;Ring Type 2 w

— c

o 3

P : ..

iz %

a0 3]

s 3

TR 3 i

= 00E007055F72

SMDR. || Twinning

Companding Law

Swikch Lire
& ULaw (&) LLaW Line
O aLaw () ALaW Line

s

[] o5 status
Auto Hold
Dial By Mame
Show Account Code
[ 1rhibit Off-Switch Forward Transfer
|:| Restrick Metwork Interconnect
[] Drop External Only Impromptu Conference

[] wisually Differentiate External Cal
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5.4. SIP Line

This section shows the configuration screens for the SIP Line in IP Office Release 6.1. To add a
new SIP Line, right click on Line in the Navigation pane, and select New = SIP Line. A new
Line Number will be assigned automatically. The settings presented here simply illustrate this

reference configuration and are not intended to be prescriptive.

5.4.1. SIP Line - SIP Line Tab

Select SIP Line tab as shown below for Line Number 10 used for AT&T and configure as follows:

e ITSP Domain Name — Set to the [P Office LANI address (192.168.62.56) configured in
Section 5.3.2 so that IP Office uses this IP address in the host portion of SIP headers such as
the From header and Diversion header.

e In Service — Default is checked

e Check OOS — Uncheck this box. If this box is checked, it enables IP Office to use the SIP
OPTIONS method to periodically check the SIP Line and if no response is received, the SIP
line 1s taken out of service. See Section 5.9 for additional information related to configuring the
periodicity of SIP OPTIONS.

e Call Routing Method — Set to Request URI (default)

IP Offices

R BOOTP (3)
4-¢7 Operator (3)
=|--%%p O0EQO7OSSF72
+-45) Syskem (1)
=4 Line (5)
a5
g, 9
g, 10
y, 11
oy, 17
+-<2 Control Unik (5)
+ -4y Extension (Z3)
H-§  User (213
+ -ﬂ HuntGroup {167
+- @ short Code (67)
@ Service (0}
ol RAS (1)
+ e Incoming Call Route (223
B8 wanPort (0}
i Directory (0)
f',“\ Time Profile {0)

SIF Ling [Transport| SIP URI|WoIP | T35 Fax|SIP Credentials

Line Mumber 10 g

ITSP Domain Mame 192[ 168.62.56

Prefix

Mational Prefix a
Country Code
International Prefix (011

Send Caller ID Diversion Header

[] REFER Suppart

SIP Line - Line 10"

In Service
Use Tel URI
Check 005

Call Routing Method

Criginator number For
forwarded and tbwinning calls

O
O

Reqguest LRI w
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5.4.2. SIP Line - Transport Tab

Select the Transport tab and set the ITSP Proxy Address to the AT&T Border Element IP
Address. The Use Network Topology Info parameter is set to LAN 1 configured in Section 5.3.2.

Default values are used for the other fields.

IP Offices :

K BOOTP (33

SIP Line -Line 10™

1 Operator (3)
(=% QOEQO7OSSF72
a9 Syskem (1)

. Cantral Uit (5) Explicit DM Server(s)

A&y Extension {28)

I User (21)

@ HuntGroup {16)

8% short Code (67)
e

B

Separate Registrar

=T Line (5) Metwork Configuration
5
ayer 4 Protocol W end Por
9 L 4 Protocol ucp Send Port, 2060
:' 10 Use MNetwork Topology Info
. 11 .............
T 25 e
iy ] ] ] ] | 0 ] ] ]

Zalls Route via Registrar
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5.4.3. SIP Line - SIP URI Tab

Select the SIP URI tab and click the Add... button to add a new SIP URI. Configure the New
Channel section displayed as follows:
Local URI — Set to the DNIS sent by AT&T IP Toll Free service in the SIP URL. In this
example it is set to 000001017 which is one of the DNIS mentioned in Table 1.
Registration - Set to 0: <None>
Incoming Group and Outgoing Group — Set to 110

Repeat above steps for other DNIS provided by AT&T.

IP Offices Ei SIP Line - Line 10"

& BOOTP (3) SIP Line | Transport| STP URT walP | T38 Fax| SIP Credentials

¥ Operator (3) -

[=)-*#=p O0EQOTOSSF72 | Channel  Groups Wiz Local URI Contack  Display Mame  PAI Credential | Max Calls
w20 Syskem (1) |1 110 110 2,., 000001017 Mone 0 <Nom,., 10
=14 Line {5) 2 110 110 2,., 000001015 Mone 0 <Nom,., 10

o5 | 3 110 110 Z,., 000001019 Mone 0: =Non,.., 10
y, O 4 110 110 2... 000001020 MNone 0: <Mon... 10
W, 10 5 110 110 2... 000001021 MNone 0: <Mon... 10
' | B 110 110 2... 0000017 Mone 0: <Mon... 10
" 11 | 7 110 110 Z... 00000017 Nore  O: <om.. 10
T 17 |8 110 110 2. 000003171017 Mone ¢ <Mom... 10
<2 Contral Unit {5) 9 110 110 2,., 00000415317... Mone 0 <Nom,., 10
Ay Extension (28) |
E User (21}
5§ HunkGroup (18)
@ short Code (67)
B Service (0)
ol RAS (1)
@ Incoming Call Raute (22)
B2 WarPort ()
@ Directory (0)
flﬁ Time Prafile (0)
@B Firewall Profile (1)
B8 1P Route (3) :
e Account Code (0D Edit Channel
B License (72) Via 205.168.62.56
W Tunnel sy 0 W s U
fi3 User Rights (8) Local URT 20000 0 “
¢ ARS (1)
" RAS Location Request (0) sonlack Use Internal Data it
fi® E911 System (1) Display Mame Use Internal Data »
PAI Maorne R
Regiskration 0: <Mone> W
Incoming Group 110
Cukgoing Group 110 |
Max Calls per Channel (10 £
AT:Reviewed Solution & Interoperability Test Lab Application Notes 25 of 46
SPOC 6/3/2011 ©2011 Avaya Inc. All Rights Reserved. IPO61IPTF




5.4.4. SIP Line - VoIP Tab

Select the VoIP tab and configure as follows:

e Compression Mode — Set to Automatic Select from the drop-down list

e DTMEF Support - Set to the default value RFC2833.

e Re-invite Supported — Check to allow for codec re-negotiation in cases where the target of an
incoming call or transfer does not support the codec originally negotiated on the trunk

e Use Offerer’s Preferred Codec — Check this box so that the top codec offered to IP Office is
used if IP Office supports that codec

e Fax Transport Support — Check to allow T38 fax support.

IP Offices SIP Line -Line 10™

K BOOTP (3) SIF Ling| Transport | SIP URI| YoIF  (T38 Fax| SIP Credentials
1 Operator (3}
(== 00E0070SSF72 Compression Mode Aukomatic Select v WoIP Silence Suppression
2y System (1) =
_ Fax Transport Suppork
=9 Line (5) Call Initiation Timeouk (s) 4 &
o 5 Re-invite Supported
"y, 9 DTMF Suppart RFC2333 L
e, 10 Use Cfferer's Preferred Codec

Since default values were used for T38 fax and AT&T IP Toll Free does not require registration,
the T38 Fax and SIP Credentials tabs need not be visited. Click OK (not shown) to commit the
SIP Line configuration.
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5.5. Users, Extensions, and Hunt Groups

In this section, examples of IP Office Users, Extensions, and Hunt Groups will be illustrated. In
the interests of brevity, not all users and extensions used will be presented, since the configuration
can be easily extrapolated to other users. To add a User, right click on User in the Navigation
pane, and select New. To edit an existing User, select User in the Navigation pane, and select the
appropriate user to be configured in the Group pane.

5.5.1. Digital Telephone User 205

The following screen shows the User tab for User 205. This user corresponds to a digital phone.

IP Offices = Extn205: 205
R BOOTP(3) &3 User | Vaicernail | DND ShortCodes || Source Mumbers || Telephony | Forwarding | Dial In || Yoice Recordin
¢ Operator (s o
[=-%=y OOEQO7OSSF72 TMare Extnz205
| —
7 Line (2) Password
- Cnntrn! Unit () Canfirm Passward
_@ EXtBnSIDI‘I (26) .............................................................................................
=-§ User(19) Full Hame
=' wWoldsger 9
i RemoteManager Extension °
& 206 Extz08 Locale 7
§ 201 Extnz01
& 20z Extnzoz Priority
& 203 Extnz03
&.—, 204 ExtnZ04 System Phone Rights Mone “
§ 205 Extrzos O B|_| .................. % ............................................................ =
§ 210Extnz10 roe e b
ﬁ-—r 32006 Extn32006 D Receptionist
§ 32005 Extn3z008
Enahle SoftPh
§ 32009 Extnazona -
ﬁ GEES013 Extn6665013 [] Enable one-3 Portal Services
ﬁ 6665014 Extnaaes014 Enable one-x TeleCommuter
a BAE5015 Extne665015
§ 6665016 Extnaces016 [] Ex Directory
a BAE5017 Extng6a5017
Drervice
a GAE5015 Extne665015 e Avaya 1416
§ 6665019 Extnsees019 i
ﬁ HunkGroup (4) Idser Rights
“ Short che [:65:] ...........................................................................................
B Service (0) g e e b
al; RAS (1) working hours time profile
@Ploomngalrouesy WL o ST
Eﬁ witanPort {0} wWarking hours User Rights w
-~vectoryy 2220202 o®n..
£ Time Profile (0) Out of hours User Rights
Hon
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The following screen shows the Extension information for this user. To view, select Extension and
the appropriate extension from the Navigation pane.

IP Offices B Digital Extension: 73
K BOOTR (3) A || Extn |
{7 Operatar (3)
=) DOEOOTOSSFT2 Extensian Id 73
ey System (1) e e
1% Line (2) Base Extension -
== Conkrol Unit (5) Caller Display Type
(=) 4y Extension (Z6)
& 1201 Reset Yolums After Calls 1
“wy, 001 202
", 8005 203 Device type Avaya 1416
“wy, BO0Z 204
ﬁm Module BD4
wooizzos e B
< 2210 Port 1
meozost &S 442 -
g, G006 4055 Disable Speakerphone ]
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5.5.2. IP Telephone User 203

The following screen shows the User tab for User 203. This user corresponds to an Avaya 1616 1P
Telephone that is configured as power user with IP Office Softphone features enabled as shown

below.

IP Offices

K BOOTP (3)
1 Operator (3)
(=)= OOEQO7OSSF72
a9 Syskem (1)
5 Line (3)
“=» Control Unik {5)
A&y Extension {26)
BI User (20)
: Mollser
: RemoteManager
& 206 Ext208
§ 201 Extnz01
& 20z Extnzoz

& 204 Extnzod
§ zo05Extnzos
§ =z1oExtnzio
& 32006 Extn3z008
32008 Extn32008
32009 Extn32009
6665013 ExtnBE65013
6665014 ExtnBaas014
6665015 ExNBE65015
BEE5016 ExNEEE5016
BEE5017 ExiNBEE5017
6665015 ExNBE65016
BEE5019 ExNBE65019
&+ 250 Robert

@ HuntGroup {100
B short Code (85)

@ Service (1)
ally RAS (1)
@ Incoming Call Rouke {113

B8 wanPart (0)

am Directory (0)

A | user | vaicemail | DD
MNarme
Password

Confirm Password
Full tame

Extension

Locale

Priarity

System Phone Rights

Profile

Device
Tvpe

User Rights

User Rights wview
WWorking hours time profile
‘Working hours User Rights

Qut of hours User Rights

E fAvaya 16161

ShortCodes | Source Mumbers || Telephony || Forwarding || Dial In || Voice Recordi
Extn2|2|3 ..................................................................................
****** ...................................................................................
é.*.u.k.*.“.k.*.“.k ...................................................................................
R

B
s v
More “

D Receptionist
Enable SoftPhone
Enable one- Portal Services

Enable one-x TeleCommuter
[] Ex Directary
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The following screen shows the Voicemail tab for this user. The Voicemail On box is checked,

and a voicemail password can be configured using the Voicemail Code and Confirm Voicemail
Code parameters.

IP Offices B Extn203: 203

‘F BOOTR (2) &3 User | “Woicemail |DND ShortCodes | Source Mumbers | Telephony | Forwarding | Dial In || Voice Reco
¢ Operater(z 40—
% O0EQD7OSSF7EZ Yoicemail Code Hokk | Yoicemail On
o systemy 0 e , .
£ Line (2) Confirm Voicemail Code | **** | [[] woicemail Help
1
- Contro! Linit (5) Yaicennail Email [[] waicemail Ringback,
A&y Extension(ze) | T T
= a User (19} Waicemail Email Readin
: Maliser [T ums wieb Services
: RemaoteManager

& 206 Extzo6
§ =201 Exnz01
&" 202 Extriznz Off Copy Forward %\Iert
§r 203 Extnzoz

CTMF Breakout
§r 204 Extnzog

§ 205 Eutmzos Reception | Breakout (DTMF ) | System Default ()
i 210Exn210 Ereakout (DTMF 2) |System Default ()
§ 32006 Extnzzo0s

a 2008 ExbnZ200g Breakout (DTMF 3) ;System Default )

§ 32009 Extn3zo09

Select the Supervisor Settings tab as shown below. To allow hot desking, enter a Login Code.

IP Offices B Extn203: 203
& BoOTR (3) A | user || voicemail | DD || ShortCodes | Source Mumbers i Telephory |Forwarding Dial In | Woice Recarding || Buttan P
i+ Cperator (3}
[=)-*=p OOEOO7OSSF7Z Call SettingsJ Supervisar Settings | Multi-line Options | Call Log
s System (LY [ ]
17 Line (2) Login Code ok, [ Force Login
. Contro! Uniit {57} Lagin Idie Period (secs) | [ Farce Account Code
Ay Extension (26) !
= i User {190 Manitor Group
: Maollser
: ReemoteManager Coverage Group %
e 206 ExkZ06 1 )
- | Qukgaing Call Bar
201 Extnzil Status on Mo-Answer Logged On (Mo change) | O qaing
e 202 Extn202 Reset Longest Idle Time [ 1nhibit Qff-Switch Forward Transfer
o 203 Exknz03 D an Intrude
e 204 Extn204 @ allCalls
205 Extnz05 @ - } Cannot be Intruded
whernal Incarming
210 Extnz10 [[] can Trace Calls
e 32006 Exkn32006
32008 Extn32008 [ Cr agent
32003 Extn32009 Automatic After Call Wark
FEAENT 3 Frbnf AR S ]
AT:Reviewed Solution & Interoperability Test Lab Application Notes 30 of 46
SPOC 6/3/2011

©2011 Avaya Inc. All Rights Reserved. IPO61IPTF



Select the Call Settings tab as shown below. Check the Call Waiting On box to allow an IP
Office Softphone logged in as this extension to have multiple call appearances (e.g., necessary for

call transfer).

IP Offices

K BooTr (3
i Operator (3}
(=% DOEOO7OSSFT2
#2) System (1)
4 Line (3)
<2 Control Unit {5}
Al Extension (26)
= ﬂ User (20)
firg MoUser
§rg RemateManager
£ 206 Extz08
§ 201 Extnz01
§ 202 Extnzoz
§ 203 Extnzo3
§ 204 Extnzod

A0 | User || voicemail | DMD

shortCodes | Source Numbersl Telephary EForwarding Dial In || Yoice Recording | Button Progra

=] Extn203: 203

Call Settings |Supervisor Settings | Multi-line Options | Call Lag

Outside Call Sequence
Inside Call Sequence
Ringback Sequence

Mo Answer Time (secs) ;15 &

Wirap-up Time {secs)

Transfer Return Time (secs) ;Off &

Call Cast Mark-Up |00

Call Waiting ©n
Answer Call Waiting On Hold {Analogue
[ Busy on Held

Offhook Station

The following screen shows the Extension information for this user, simply to illustrate the VoIP
tab available for an IP Telephone.

IP Offices

R BoOTP (3)

4o+ Operator (3)

= OOEOOFOSSF?2

29 System (1)

9 Line (3)

<2 Control Unit {(5)

Ay Extension (26)
4 1201
g, 5001 202
Wy, 3005 203
o, G002 204
A 73205
"y, BO1Z2 206

(1] - -

Al|Edan | vor |

E H323 Extension: 8005 203

1P Address [0 0 0 0
MaC Address
Compression Mada
TOM-=IP Gain
IP-=TOM Gain

Supplementary Services éNone w

|:| WolP Silence Suppression

0O Enable Faststart for
non-avaya IP phones

out Of Band DTMF
[ Local Tanes
Allows Direct Media Path

[] reserve Avaya IP endpaint license

[] Reserve 3rd parky IP endpaink license
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5.5.3. SIP Telephone User 220

The following screen shows the User tab for User 220. This user corresponds to an Avaya 1140E
SIP Telephone and configured as below:

IP Offices

¥ R BOOTP (3)
# g Operator (3)
= = DOEOOTOSSFT2

= = System (1)

=5 OOEOOTOSSFTZ
17 Line (4)
= Control Unit (5)
Ay Extension {30)
§ userizy

;ﬂ Nollser

g RemoteMansger

§ 201 Exnz0n

i~ 202 Extnzoz

i~ 203 Extnz03

i 204 Eatnz0d

i 205Exnz0s

i~ 208 Extnz0s

§ Z0Extnzi0

i 220 Extnz20

i 221 Extnz21

i~ 32008 Extriz2008
F200B Extr3Z008
32009 Extn3Z009
BE45013 ExtnAteS1 3
BE55014 Extné6a5014
6665015 ExinGE65015
BE65016 Extno663016

T3

Password
Confirm Pagsword
Full Hame:
Extengion

Locale

Pricrity

Sysbem Phone Rights

Dievice
Type

L

ExknZ20

LR L

LR

Aaya 1140

£

3

Hone

Basic Unar

[ receptionist

Enable SoftPhone

Extn220: 220

Woucemal | DWND | ShortCodes  Source Mumbers | Telephony | Forwarding | Dial In || Yoice Recordin

[[] Enabie one-x Portal Services

Enable one-¥ Tel=Comutes

[] Ex Directory

Awaya 1140E Sp

The following screen shows the Extension information for this user. Note that for a SIP telephone,
the IP Address configured for the phone needs to be specified. In this example, 10.80.130.51 was
assigned to the Avaya 1140E telephone. All other screens are configured the same way as in

Section 5.5.2.

IP Offices

K Bo0TR (3)
i+ Operator (3)
[=)-%=p OOEQOYOSSF72
“2p System (1)
T4 Line (4)
<2 Control Unit {5)
4y Extension (30)
41201
g, 5004 202
g, B00S 203
g, G005 204
Ay 73205
W, 8013 206
A& 2210
g, 8001 220

-E-E-E

Al Edn | voIP | 738 Fax

E SIP Extension: 8001 220

I Address (10 B0 . 130 . 51 |

Compression Mode |.|'.\utomatic Select W |
TOM-=IF Gain Default v
IP->TDM Gain Default v|
DTMF Support |RFC2833 w |

D “oIP Silence Suppression

|:| Fax Transport Suppork

] Local Hold Music

allow Direct Media Path

Re-invite Supported

] Use Offerer's Preferred Codec
Reserve Avaya IP endpoint license

] reserve 3rd party IP endpoint icense
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5.5.4. Hunt Groups

Hunt groups were used in this reference configuration to route the incoming calls on a SIP Trunk
from AT&T Toll Free service to the an agent with the right skill set. To configure a new hunt
group, right-click HuntGroup from the Navigation pane, and select New. To view or edit an
existing hunt group, select HuntGroup and choose the appropriate hunt group from the Navigation

pane.

The following screen shows the Hunt Group tab for hunt group 11. The group name is set to
Receivables. Several extensions/agents are part of this hunt group. Since the Ring Mode field is
set to Rotary, this will enable the telephones to ring in a round robin fashion. Click the Edit

button to change the User List. Once a user is part of a hunt group User List, it can be

enabled/disabled by checking/unchecking the box in the Extension field.

IP Offices Ei

K BOOTP(3)

47 Qperator (3)

[=-%% D0EOOTOSSFTZ

#2y System (1)

“% D0EO0FOSSFT2

T4 Line (4)

<2 Contral Unit (5)

Ay Extension (30)

ﬂ User (21}

= -ﬂ HunkGroup (16)
i 13 Biling
ﬁ 14 CustomerService
S 102 N3NS009
i 103 NSNSO10
S 5081 NSNS061
i 5082 NSNS06Z
i 3670 ORT3670
ih§ 69542 ORTEOE4Z
W 12 Pavables
4 11 Receivables
5§l 100 Sonus10Digits

B

-

m

[

Mame
Extension

Ring Maode
Overflow Made

Haold Music Source

Agent's Status on Mo-Answer

Applies To

User List

Extension Mame
201 Extnz01

| 20z Extniz0z
|0 210 Extr210
[0 =zo08  Exen3zons
| [] 32009  Extn3z009
| 205 Extniz05

Hunt Group | Yoicemail | Falback | Queding | Yoice Recording | Announ

Rotary Group

Receivables

Rakary L
™
Mo Change R
Mew ™

Under the Queuing tab, check the Queuing On box and set the Queue Length field to any
desirable value. Use the default values for all the other fields.

IP Offices

R BOOTP (3)
w Operator (3)
[=-*% O0EO07OSSF72
a3y System (1)
4 Line (5)
<2 Conkrol Unit {S)
Ay Extension (28)
a User (213
(=58 HunkGroup (16)
2F 13Biling
-&1 14 CuskomerService
AF 102 NSNS009
Sl 103 NSNSO10
2 5061 NSHS061
AF 5062 NSNS062
AF 3570 ORT3670
S 69542 ORTE9842
-&1 12 Payables

ﬂ 11 Receivables

Ei

Rotary Group Receivables:

Hurt Group | Yoicemail | Fallback | QUeUing | Voice Recording | Announcements | SIP

Queuing on

Queue Length 5 £ Mormalize Queue Length
Queue Type Assign Call On Agent Answer W

Calls In Queus Alarm

Calls In Queue Threshold

Analog Extension to Motify <Mone= w
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Under the Announcements tab and check the Announcements On box. The wait time can be set
to any desirable value. These announcements are played if an agent for a particular skill is

unavailable.

IP Offices 4

=

BOOTP (3)
Ciperator (3
» DOEO07OSSF72
3y System (1)

% O0E007055F72
7 Line (4)
2 Control Unit (5)
Ay Extension (300
ﬁ User (213
=) -ﬂ Hunt@roup {16)
2§ 13 Eilling
ﬂ 14 Cuskomer3ervice
W 102 HsMs009
S5 103 H3NS010
S 5061 HSMS061
S5 5062 NaMS062
S 3670 ORT3670
i§| 69842 ORTEEE4Z
S 12 Payables
5§ 11 Receivables
S5 100 Sonus10Digits
S5 4891 Sonus4891
S 4892 Sonus489z
S5 101 Sonus4Digits
S 0193 TDMO193
SR 0194 TDMO194

al i

=

5
i
ES

D

EaRE

Hunt Group | Yoicemail | Fallback | Queuing

Announcements On

Wait before 15k announcement (seconds)

Flag call as answered

Post announcement tone

2nd Announcement

Wit before 2nd announcenent (seconds)

Repeat last announcement

Wait before repeat (seconds)

Rotary Group Receivables: 11*

Yoice Recarding | Announcements | S1p

[] svnchronise Calls

e [

Play 1st announcement

e

Additional hunt groups Billing, Payables and Customer Service were created in this reference
configuration to exercise the Call Center functionality within IP Office.
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5.6. Short Codes

In this section, various examples of IP Office short codes will be illustrated. To add a short code,
right click on Short Code in the Navigation pane, and select New. To edit an existing short code,
click Short Code and select the code to be edited in the Navigation pane.

5.6.1. Call Center Codes

Call Center functionality is configured on Voicemail Pro. Section 5.8 lists some of the
configuration steps to provide this functionality. In order to access this functionality, short codes
can be used. In this reference configuration, CallCenter was configured on Voicemail Pro. The
following screen shows the short codes set for this functionality.

IP Offices B *93: Voicemail
B F4THNR # || Short Code
8K *46 '
B +47 Code *33
BXFAE |
X *49 Feature VoicemallColet | he]
Bx 50 Telephone Murber | "CallCenter”
>t ==
B *sz Line Group Id a ~
@ sz
B HSTHENR Locale b
@ 87 Force Account Code [
B FTOFNR
B FTIRNR
@ a0
@ *3000%
g *a1n;

5.6.2. Voicemail Retrieval Code

To retrieve voicemails left in individual mailboxes, this code was configured in this reference
configuration. When a user enters, *17, they can retrieve the messages in their mailbox.
Additionally, this short code can be also in the Incoming Call Route configured in Section 5.7.

=] T e e

Short Code
Code *17
Feature ‘oicemail Colleck v

Telephone Mumber  |7U

Line Group Id a w

Locale -

Force Account Code [ ]
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5.7. Incoming Call Routes

In this section, IP Office Incoming Call Routes are illustrated. Each Incoming Call Route will map
a specific AT&T IP Toll Free DNIS to a destination user, group, or function on IP Office. To add
an incoming call route, right click on Incoming Call Route in the Navigation pane, and select
New. To edit an existing incoming call route, select Incoming Call Route and the appropriate
route in the Navigation pane.

The screen shown below matches the AT&T IP Toll Free DID 000001017 in the Incoming
Number field on the Line Group Id (110). The Line Group Id matches the Incoming Group
field and Incoming Number matches the Local URI field configured in the SIP URI tab for the
SIP Line to AT&T IP Toll Free service in Section 5.4.

IP Offices ﬁ 110 000001017*

47 Operator (3) || Standard | Yoice Recording | Destinations
9% ooEOO7OSSFRZ2. 0 Y
(=% System (1) Bearer Capability (Anywoics | b
: "-.-.\,_J OOEOO7OSSF?2 Line Group Id 10 pr
R L —
“=» Contral Unit {5) Incorming Murnber 000001017
i
§ userizi) Incarning Sub Address

ﬁ HuntGroup {16) T
I LI
8% short Code (67) peomingllooo

£ Service (0) Laocale o
s RASC o e
= Incoming Call Raute (22) Priority 1-tew Ml

@ 1o
9 Digit DNIS
@ 110 00000017 e ke
@ 110000001017 Hold Music Source System Source ~

e fioogooooiola 2 By s s e

Select the Destinations tab and a value can be either selected from the drop-down list or manually
entered. In the screen shown below, the hunt group configured in Section 5.5.4 was selected.

110 000001017

Standard | Yoice Recnrdingé Destinations |

TimeProfile Destination Fallback Extension

[ Defaulk value 11 Receivables
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Similarly, in the screen below, an extension configured in Section 5.5.2 was selection.

i

110 000001017

TimeProfile Destination Fallback Extension

z Default Yalue

205 ExtnZ05
6665013 Extne665013
6665014 Extneeas014 T
6665015 Extne665015
6665016 Extneeas016
6665017 Extne665017
6665018 Extneeas015 bt

The following screens displays how a short code can be manually assigned in the Destination field
to route the call for voicemail retrieval and access Call Center functionality.

110 000001017*

Standard Woice Recarding | D

TimeProfile Destination Fallback Extension

& Default Yalue |m w

Standard ‘foice Recording

TimeProfile Fallback Extension

z Default Yalue ~ |

The following screen displays another mechanism to access the Call Center functionality without
using the short code. The Call Center functionality is configured in Voicemail Pro as detailed in
Section 5.8.

110 000001017

| standard | voice Recarding | Destinations

TimeProfile Destination Fallback Extension

L4 Default value I CallCenter “
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5.8. Call Center Provisioning in Voicemail Pro

The call center functionality was configured in Voicemail Pro. Following steps highlight the
configuration of this functionality. For further information, consult [[PO-VMPRO].

1. Navigate to Start-> Voicemail Pro Client and right click on modules and select Add to add a
new module.

2 &
.
.
2. In the screen below, enter CallCenter in the Name field and click OK.
Adding a new start point E|
Mame
CalCented
I QK. l l Cancel ] [ Help ]

3. Following screen is displayed indicating the starting point for the Call Center functionality.

Modules > CallCenter

4. Under the Actions tab, select Basic Actions [not shown]. Select Menu and place it on the right
side of the pane and then connect the Start Point to Menu as shown below:

Modules > CallCenter

Start Poirt
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5. Right click on Menu and select Touch Tones tab. Check the appropriate boxes. In this
reference configuration, 1, 2, 3, 4, Timeout and Invalid boxes were selected. This allows caller
to enter any of the digits from 1 to 4 to go to the appropriate agent. Digit 1 was used for
Receivables, Digit 2 was used for Payables, Digit 3 was used for Billing and Digit 4 was used
for Customer Service Hunt Groups/Skills in this reference configuration. Digits have to be
entered within a certain time and within the specified range otherwise an error recording may
be played. Enter any valid number in the No. of Retries field. This field dictates the number of
retries allowed to the caller for entering a digit.

Properties for Menu El
General | Entry Prompts | Touch Tones | Reporting | Results
R
2
3
4
15
s
r
s
s
[Ja
D E3
[]#
Invalid Input Handling
4 : Mo of Retries Prompt
L C— : L [Tr—— B
it Invathnt[_l,nwav ................................. E]
I QK l l Cancel ] l Help

Click OK and following screen is displayed:

Modulesz » CallCenter

Start Point

Timeout

revalid

TR
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6. Right click on the Menu action and select the Entry Prompts tab and click on the % sign [not
shown]. On the following screen, enter the Extension where the recording is done and the
filename for the recording in the Please select a file or enter a new file name field and press
the Red record button as shown. In this reference configuration the phone at extension 203 rings
and Voicemail Pro prompts the user to record an announcement which is played back to the
caller when the call comes into IP Office.

Wawve Editor, E |

Uze which madia device?

;Startlwav E]

Relative to: "C:\Program FileshdwapatlP Office\Yoicemail Proiyhd\wavsh

Wave Information

Wave Length: 9.3 zeconds
Sample: 1E kit
Sample Rate: Bkhz
Channels: Mano

| IBEICY
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7. Under the Actions button, select Transfer [not shown]. Repeat this step for additional actions.

In this reference configuration four Transfer actions were created for each of the selections in
Step 5 and connected to them.

Modules > CallCenter

Start Poirt

Tirmeout
Irrvalid
n
|2
Ii
4

pury

[a}

Right click on the Transfer action and select the Specifics tab. In the Destination field enter the
hunt group/skill number created in Section 5.5.4 and click OK. This will enable the call to be
routed to the appropriate skill. Repeat this step for all the Transfer actions.

Properties for Transfer fg

General | Entry F'mmptsl Specific EF!epnlting Resultz

Transfer call to

Destination

[] Set Caller Priority

[ Maotify Caller of Transfer to T arget

QK. l [ Cancel ] [ Help
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5.9. SIP OPTIONS Frequency

From the Navigation pane, select User and then select the user named NoUser. In the NoUser
Details pane, select the tab Source Numbers. Press the Add... button to the right of the list of any
previously configured Source Numbers. In the Source Number field shown below, type
SIP_USE_PAI_FOR _PRIVACY. Click OK.

Similarly SIP OPTIONS frequency was configured by adding another source number by entering
SIP_OPTIONS PERIOD=2 in the Source Number field. This will set the frequency of the SIP
OPTIONS message sent by IP Office to 2 minutes.

Mew Source Mumber
Source Mumber SIP_OPTIONS_PERIOD=2|

NoUser: *

IP Offices

3y System (13 ~
17 Line (5}

User || Voicemail | DND || ShortCodes | Source Mumbers | Telephony | Forwarding | Cial In | Yoice Recording | Button Programming | Menu Programming | Mobility | Phone € 3|

“= Control Unit (3} Source Mumber
& Extension (28) SIP_OPTIONS_PERIOD=2
=]} a User (21) Remove
: Naollser
‘ﬂ RemoteManager Edlib:
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5.10. Saving Configuration Changes to IP Office

When desired, send the configuration changes made in IP Office Manager to the IP Office server,
to cause the changes to take effect. Click the “disk™ icon that is the third icon from the left (i.e.,
common ‘“‘save” icon with mouse-over help “Save Configuration File). Click Yes to validate the

configuration, if prompted.

IP Office Manager

"_\ The configuration has not been validated.
. Perform validation before saving?

Once the configuration is validated, a screen similar to the following will appear, with either
“Merge” or “Immediate” selected, based on the nature of the configuration changes made since the
last save. Note that clicking OK may cause a service disruption. Click OK if desired.

AT:Reviewed
SPOC 6/3/2011

Send Configuration |Z||§|rz|
IP Ciffice Settings

O0EOOFOSSF72

Configuration Reboaot Made
(%) Merge

) Immediate

() When Free

0 Timed

Reboot Time

Call Barring

[ QK H Cancel ][ Help
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6. Verification Steps

The following steps may be used to verify the configuration:

6.1. General

e Place an inbound call, answer the call, and verify that two-way talk path exists. Verify that the
call remains stable for several minutes and disconnect properly.

e Place an inbound call to an agent or phone, but do not answer the call. Verify that the call
covers to Voicemail Pro and messages can be retrieved using the appropriate short codes.

e Use the System Status application to verify the status of trunks, extensions and call progress.

e Use the Monitor application to monitor the activity on IP Office.

7. Conclusion

As illustrated in these Application Notes, Avaya IP Office can be configured to interoperate
successfully with the AT&T IP Toll Free service. This solution provides users of Avaya IP Office
the ability to support inbound toll free calls over an AT&T IP Toll Free SIP trunk service
connection via MIS/PNT transport.

The reference configuration shown in these Application Notes is representative of a basic enterprise
customer configuration and is intended to provide configuration guidance to supplement other
Avaya product documentation. It is based upon formal interoperability compliance testing as part
of the Avaya DevConnect Service Provider program.
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This section references documentation relevant to these Application Notes. In general, Avaya
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enterprise/ip-toll-free-enterprise/
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